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Lock&Track Overview 

Welcome to the Lock&Track SM Corrections Information System . Lock&Track  is an easy-

to-use inmate and jail management application package for corrections staff and 

administrators, as well as law enforcement personnel. It provides instant access to inmate 

and offender information, intake, incarceration, and release and post-release activities. 

Lock&Track  uses Windows commands, conventions and controls throughout, such as 

tabbing to move to the next field, short-cut or hot keys, a toolbar, title-bar buttons and drop-

down menus. Lock&Track  presents information as application desktops, each of which 

focuses on a particular aspect of a correctional duty or job. Each desktop contains menus 

and screens for data entry, modification and review, and production of reports. 

If you can work in a Windows environment, you can easily and quickly learn how to operate 

L&T . 

LETȭS GET STARTEDȣ 

HOW TO LOGIN 

To start, double click on the LTClient icon or choose LTClient from your application menu 

to display the login window: 

 Host: this is the server you wish to connect to.  For Lock&Track Online the value is 
lto.locktrack.com .  Other customers should request this value from IT or LockWorks 
staff.  

 Desktop : the application you wish to use.  We will demonstrate the LT  
application.  

 Username: Generally LASTNAME_INITIAL : WILLSON_S  Created by 
LockWorks or IT staff for you. 

http://lto.locktrack.com/
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 Password : The first time you use LockWorks, your password will be 
NEWUSER.  You will be asked to change this before proceeding.  Do not 
lose your new password. 

PASSWORDS 

 Your password must be at least six characters long and composed of the  letters A through 

Z, the digits 0 through 9 and/or the special characters $ (dollar sign) and _ (underscore). 

Your password cannot be a word in a dictionary.  We suggest thinking of a phrase you will 

not forget and using the first letter of each word,.  For example the book title 4ÈÅ 3ÈÅÒÉÆÆȭÓ 

Guide To Corrections Facility Discipline becomes TSGTCFD.   Use your imagination, but make 

the password one that you will remember. Note: Username and Password are not case-

sensitive; you can enter these using UPPER- or lower-case letters, or any combination. 

/ÎÃÅ ÙÏÕȭÖÅ ÅÎÔÅÒÅd your password and confirmed it, as shown below, click the Submit 

button (or press EnterɊ ÔÏ ÒÕÎ ÔÈÅ ÄÅÓËÔÏÐ ÙÏÕȭÖÅ ÓÅÌÅÃÔÅÄȢ 

 

LOCK&TRACK CONVENTIONS 

WINDOWS   CONVENTIONS 

L&T  screens use standard Windows methods for accomplishing any task at hand. Click in a 

data field (box) and type to enter information. Tabbing moves you to the next logical field. 

Some fields include drop-down lists, which aid accurate consistent data-input.  Context-

sensitive tips appear if you hover over a field.  Toolbars and drop-down menus include 

standard Windows functions.  For example, the Edit menu should look familiar: 
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The concept of the toolbar should also be familiar to Windows users.  The specific functions 

are outlined in the Appendix. 

DESKTOP CONVENTIONS 

 Required fields are highlighted with a colored background. Errors in data entry, such as 

entering a date in the wrong format cause the background to change.  The default colors are 

blue for required fields and yellow for errors, but these background colors can be changed 

to fit your personal preference.  Dropdown menus and many buttons include keyboard 

command tips to speed tasks as you become familiar with the software.  A help menu 

provides access to additional supporting materials. 

MAIN MENU 

&ÏÒ ÐÕÒÐÏÓÅÓ ÏÆ ÉÌÌÕÓÔÒÁÔÉÏÎ ÉÎ ÔÈÉÓ 5ÓÅÒȭÓ 'ÕÉÄÅȟ ÅØÁÍÐÌÅÓ ÏÆ ÔÈÅ Lock&Track  Jail desktop 

will be shown. Although you may be using a different L&T  desktop, all desktops follow 

similar operational principles. 

Once logged in, the JAIL desktop presents a Main Menu featuring correctional functions 

listed in a logical order. 
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We will demonstrate the Intake function, as it is one of the most commonly used, but first 

we want to cover some of the basic functionality common across desktops. 

To choose an item in a menu double-click the item, or highlight it and choose Ȱ'Ï4Ïȱ or click 

the right arrow in the button-ÂÁÒȢ  ! ÍÅÓÓÁÇÅ ÍÁÙ ÁÐÐÅÁÒ ÂÅÌÏ× ÔÈÅ Ȱ'Ï4Ïȱ ÔÅØÔ ÔÏ ÉÎÄÉÃÁÔÅ 

an action is in progress if your network requires a moment to complete your request.  The 

Intake Screen appears with context-sensitive navigation:  
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NAVIGATION BUTTONS 

Lock&Track  also has Navigation buttons to help you maneuver through the screens, and 

Function buttons which perform an operation. These buttons are found under the 

application screens and are context sensitive, changing as you move through the software.  

Function options are indicated with a ¤ symbol.  Tool tips indicate keyboard equivalent. 

 

For example the ¤Where button calculates the current location of the offender, while the 

Info button navigates to a new menu with additional options.  Note that some functions and 

some navigation options will not work without a current record loaded.  From the sub-

menu Info, double-clicking the menu item Last Known Address will display a screen 

listing that address, as shown below.   

Note that screens can be layered on top of each other. To remove the top screen from your 

desktop, click the GoBack navigation button, or the left pointing arrow at the top of the 

window. 

ACCURATE DATA ENTRY 

VALIDATION LISTS 

Validation lists simplify accurate data entry for fields with limited numbers of valid entries. 

For example, the drop-down list for State includes the 50 states in the U.S.  If you try to 
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enter a value into a validation list field which is not a member of that list, that value is 

rejected.   These lists can be customized by installation. 

 

DATES AND TIMES 

$ÁÔÅÓ ÁÒÅ ÅÎÔÅÒÅÄ ÉÎ ȰÍÏÎÔÈȾÄÁÔÅȾÙÅÁÒȱ ÆÏÒÍÁÔ ×ÉÔÈ ςτ-hour (or military) times.  Clicking 

on the  box located next to date fields will bring up a calendar for ease of entry.  Note the 

arrows shown below for moving forward and backward through the months.  For efficient 

manual entry, only the digits are typed, with punctuation supplied by the software.  For 

example, 03/08/2003 03:22 is entered by typing 030820030322. 

 

MEMO FIELDS 
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While many of the Lock&Track ȭÓ ÆÉÅÌÄÓ ÁÒÅ ÒÅÓÔÒÉÃÔÅÄ as to how many characters can be 

entered, many screens also provide one or more fields where you can enter unlimited text. 

These are called Memo Fields and are accessed by clicking on the  button next to a 

label.  Here we see the Property Storage window with memo field in the foreground. 

After the information has been entered, you can send it via email to another party (1 

below), save it to the database (2 below) or print it (3 below).  This information also can be 

saved to a clipboard, using the cut and paste function, for use in another program. 

 

MESSAGE AND STATUS LINE 

The L&T  application window includes a message and status line to provide contextual 

prompts. For example, if you are searching through a list of data records and you are at the 

end of the list, the message box will show No records found.   

4ÈÅ ȰMȱ ÉÎ ÔÈÅ ÓÔÁÔÕÓ ÂÏØ ÓÈÏ×Î ÁÂÏÖÅ ÔÅÌÌÓ ÙÏÕ ÔÈÅ ÒÅÃÏÒÄ Ïn the screen has been modified 

and not yet committed.  Other indicators that can appear in the status box include: 

 ̧ ȰRȱȟ ×ÈÉÃÈ ÍÅÁÎÓ ÔÈÁÔ Á ÒÅcord is on the screen. This data record is the one that 

you have sought to retrieve to review and/or update. 

 ̧ ȰRMȱȟ ×ÈÉÃÈ ÍÅÁÎÓ ÔÈÅ ÒÅÃÏÒÄ ÉÓ ÂÏÔÈ ÏÎ ÔÈÅ ÓÃÒÅÅÎ ÁÎÄ ÍÏÄÉÆÉÅÄȢ 
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The message line also is an important place to look for key information throughout the 

process. For example, suppose you tried to save changes to a record but required fields 

were missing values. If any required field is empty, the cursor is moved to that required 

field (which is typically shaded blue) and the message, Required field, is displayed.  

Finally, context sensitive tips appear on the far right.  In the case shown, the cursor is in the 

RName (Rest of Name) field.   

ON-LINE HELP 

Help is available when you are in the middle of a function. To get to help or a specific screen, 

click the Help drop-down menu item, then click on Screen Help.  This will open your 

default Internet browser to access Lock&Track ȭÓ Web-based Help Library.  

A box will appear for you to enter your USERNAME and PASSWORD. You are given the 

option of saving the password so that you will not have to log in every time you use online 

help.  Click OK and online information will appear. Since you clicked on Screen Help, this 

information should address tasks that are on the screen in front of you. 

If the information isÎȭÔ ÅØÁÃÔÌÙ ×ÈÁÔ ÙÏÕ ÁÒÅ ÌÏÏËÉÎÇ ÆÏÒȟ ÃÌÉÃË ÏÎ ÔÈÅ ÑÕÅÓÔÉÏÎ ÍÁÒË 

button and a list of help items will be displayed.  Scroll through the list and click on 

the link that best describes what you are trying to do.  

To exit from Help, click on the File drop-down menu and then click on Exit or Close. 

However, if you prefer, you can leave this Help browser window open as a reference while 

you continue to use the Lock&Track  application. 

From the Help button, you also can click on Help Topics. That will give you a list of topics 

for which you may need help (i.e., Intake, Searching, Photos, etc.). Double click on a topic to 

display help text in your browser. 

LOGGING OUT 

To quit working in Lock&Track  and logout your session, click on File> Exit.  Remember to 

commit any changes still indicated with an M in the status bar before you log out!   

LOCKING AND UNLOCKING THE APPLICATION 
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)Æ ÙÏÕ ÁÒÅ ÌÅÁÖÉÎÇ ÙÏÕÒ ÃÏÍÐÕÔÅÒ ÆÏÒ ÊÕÓÔ Á ÆÅ× ÍÉÎÕÔÅÓ ÁÎÄ ÄÏÎȭÔ ×ÁÎÔ ÔÏ ÌÏÇ ÏÆÆȟ the Lock 

key will protect your session until you return and type your password.  If someone 

else needs to log you out during your absence, they can choose the exit button, 

shown below.  Note that this will end your session, but will not allow them access to 

your account. 

 WORKING WITH RECORDS 

A data record  is a collection of information which is treated as a unit. Examples include an 

ÉÎÍÁÔÅȭÓ ÉÎÔÁËÅ ÉÎÆÏÒÍÁÔÉÏÎȟ ÁÎ ÏÆÆÉÃÅÒȭÓ ÔÒÁÉÎÉÎÇ ÒÅÃÏÒÄÓȟ ÏÒ ÔÈÅ ÌÉÓÔ ÏÆ ÁÌÉÁÓÅÓ ÆÏÒ Á 

particular inmate.  Clearly records can be organized at different levels.  For end-users the 

most useful way to think about records is by the screen.  A screen of related information is a 

record which can be altered, cloned, or deleted. 

RETRIEVING AND VIEWING RECORDS 

We return to the intake screen: 
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To locate a specific record, enter information in just those fields that you can match exactly 

and click Find Data . Click the Clear All Data function key  (Shift Delete) to 

remove data from a previous record if needed.  Note that incorrectly entered information 

will cause the search to fail.  For searches where you have partial or insufficiently unique 

information, use wildcards, or use ÔÈÅ ÓÅÁÒÃÈ ÓÃÒÅÅÎ ÂÙ ÃÌÉÃËÉÎÇ ÏÎ Ȱ3ÅÁÒÃÈȱ ÉÎ ÔÈÅ ÌÏ×ÅÒ 

navigation. 

If multiple matches exist, you can move through them by clicking Find until the message bar 

informs you no more matches are available. 
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PERFORMING SEARCHES 

LockWorks products offer sophisticated search functionality, including wildcards and 

soundex (phoneme based) searching.   For example, if you have the last name and part of 

the first name, you can enter those variables in the appropriate fields (i.e., last name and 

ÆÉÒÓÔ ÎÁÍÅȟ ÓÕÃÈ ÁÓ ȰWOLF, HA*ȱ). The asterisk indicates a wildcard search, where any 

person named ȰWOLFȱ who has a first name that begins with ȰHAȱ will appear.  (A common 

error is to forget the wildcard character, which will omit partial-matches.) To conduct the 

search, click Find on the toolbar (or the Home key on your keyboard) to retrieve the 

records.    

If multiple matches exist, they will be displayed in a list.  Here we have searched on just the 

last name WOLFE, bringing up multiple matches. 
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WILDCARD SEARCHING 

For any wildcard search, enter the data that you know and use the * in the field where you 

×ÁÎÔ ȰÁÎÙ ÃÈÁÒÁÃÔÅÒ ÍÁÔÃÈÅÓȢȱ &ÏÒ ÅØÁÍÐÌÅȟ ÉÆ ÙÏÕ ÅÎÔÅÒ ȰSMITHȱ ÉÎ ÔÈÅ ÌÁÓÔ ÎÁÍÅ ÁÎÄ ȰJ*ȱ 

in the first name field, the search will retrieve anyone with the last name of Smith and 

whose first name begins with a J. That could include John Smith, Joe Smith, Julie Smith, etc. 

You can use % ÔÏ ÒÅÐÒÅÓÅÎÔ ÁÎÙ ÓÉÎÇÌÅ ÃÈÁÒÁÃÔÅÒȡ ȰSMITH, J%%%ȱ ×ÉÌÌ find John Smith and 

Jack Smith, but not Joe or Julie Smith.  

Here are some examples of searches that could be conducted: 

To find:    Enter:  Sample matches: 

!ÎÙ ×ÏÒÄ ÂÅÇÉÎÎÉÎÇ ×ÉÔÈ ÁÎ Ȱ3ȱ S*  SUE, SUSAN, SAM, SAMUEL 

!ÎÙ ×ÏÒÄ ÓÔÁÒÔÉÎÇ ×ÉÔÈ Á Ȱ*ȱ ÁÎÄ 
ending ×ÉÔÈ ÁÎ Ȱ.ȱ   J*N  JOHN, JEAN, JONATHAN 

 
Any two-letter word starting 
×ÉÔÈ ÁÎ Ȱ.ȱ    N%  NO 

Any three-letter word that 

ÅÎÄÓ ÉÎ Á Ȱ4ȱ    %%T  BAT, CAT, MAT, FAT 

Any word of exactly 

four characters    %%%% THIS, WEEK, WORD, NAME  

Other combinations of wildcard searches are permitted, such as ȰSM%T*ȱ. Names that 

could appear as a result of this search include Smith, Smythe, Smithe and Smittie. 

SOUNDEX SEARCHES 

Some names sound familiar but can be spelled in multiple ways.  To find matching records, 

or words tÈÁÔ ȰÓÏÕÎÄ ÌÉËÅȱ ÔÈÅ ÎÁÍÅȟ ÅÎÔÅÒ the way you think the name or word might be 

spelled and put a # ÓÉÇÎ ÁÆÔÅÒ ÉÔȢ &ÏÒ ÅØÁÍÐÌÅȟ ÙÏÕ ÃÏÕÌÄ ÔÙÐÅ ÉÎ ȰWOLF#ȱ, click the Find 

button (or Home key on your keyboard) and you will receive a list of last names that sound 

ÌÉËÅ 7ÏÌÆ ÂÕÔ ÍÁÙ ÂÅ ÓÐÅÌÌÅÄ ÄÉÆÆÅÒÅÎÔÌÙȢ &ÏÒ ÅØÁÍÐÌÅȟ ÔÈÅ ÓÅÁÒÃÈ ÏÆ ȰÓÏÕÎÄÓ ÌÉËÅ WOLF#ȱ 

could result in names that are spelled like Wolff, Wolf, Wolfe or Wulff. 

QUERY BASED SEARCHES 
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The toolbar also offers a search key  which will perform advanced range searching 

options, such as: 

 ̧ Finding inmates who are between 5ô10ò and 6ô2ò tall, or 

 ̧ Looking for an inmate whose date of birth was between two dates 

(i.e. between Jan. 1, 1952 and Jan. 1, 1959).  

An example of a DOB range search is shown below. 

 

RECORDS MANAGEMENT 

ADDING A RECORD    

To add a new record, start with a clear screen (Clear All Data function key or Shift 

DeleteɊȢ .ÏÔÅ ÔÈÁÔ ÔÈÅ ȰRȱ ÉÎ ÔÈÅ ÓÔÁÔÕÓ ÌÉÎÅ ÄÉÓÁÐÐÅÁÒÓȢ 4ÈÁÔ ÍÅÁÎÓ ÙÏÕ ÁÒÅ ÓÔÁÒÔÉÎÇ Á ÎÅ× 

ÒÅÃÏÒÄȠ ÔÈÅÒÅ ÉÓ ÎÏ Ȱ2ÅÃÏÒÄ ÏÎ 3ÃÒÅÅÎȱ ɀ the screen is blank.  

To enter information, click in a specific data field (box) and type in the data. You can then 

either tab to the next field or use the mouse to point and click at the next field where you 

want to enter data. Some fields include drop-down lists, so you must choose from specific 

ÄÁÔÁ ÉÔÅÍÓȟ ÓÕÃÈ ÁÓ ÔÈÅ ÃÏÌÏÒ ÏÆ ÔÈÅ ÏÆÆÅÎÄÅÒȭÓ ÇÅÎÄÅÒ ÁÎÄ ÃÏÌÏÒ ÏÆ ÈÁÉÒ ÁÎÄ ÅÙÅÓȢ 4ÈÅÓÅ ÄÒÏÐ-

down lists are also called validation lists, and the value entered for that kind of field must be 

chosen from that validation list. 
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Enter the data for all the required fields (those with colored backgrounds) as well as any 

other data you may have available to you at this time. When you enter information in the 

ÆÉÒÓÔ ÆÉÅÌÄȟ ÁÎ ȰMȭȭ ÉÓ ÄÉÓÐÌÁÙÅÄ ÉÎ ÔÈÅ ÓÔÁÔÕÓ ÌÉÎÅȢ 4ÈÁÔ ÍÅÁÎÓ ÁÔ ÌÅast one field has been 

modified on the screen. 

Press Commit    to save this new record and insert it into the Offender Database. When 

you see Record inserted in the message line, you know you have successfully added a 

record. 

TO CLONE A RECORD   

Lock&Tra ck ÁÌÓÏ ÌÅÔÓ ÙÏÕ ÃÌÏÎÅȟ ÏÒ ÄÕÐÌÉÃÁÔÅ ÄÁÔÁȟ ÓÏ ÙÏÕ ÄÏÎȭÔ ÈÁÖÅ ÔÏ ÅÎÔÅÒ ÔÈÅ ÓÁÍÅ ÄÁÔÁ 

over and over. For example you could clone a record that has housing information so that 

ÙÏÕ ÄÏÎȭÔ ÈÁÖÅ ÔÏ ÅÎÔÅÒ ÉÔ ÒÅÐÅÁÔÅÄÌÙ ÆÏÒ ÅÖÅÒÙ ÃÅÌÌ ÉÎ Á ÈÏÕÓÉÎÇ ÕÎÉÔȢ !ÎÏÔÈÅÒ ÅØÁmple is 

cloning the record of an offender with multiple alias names. This function saves you time 

because you can change the one or two data fields that are different rather than retyping all 

of the data.  

To do this, retrieve the record you want to clone. .ÏÔÅ ÔÈÅ ȰRȱ ÉÎ ÔÈÅ ÓÔÁÔÕÓ ÌÉÎÅȟ ÍÅÁÎÉÎÇ Á 

record is on the screen. Change the data in any of the fields that have different information. 

Press the  button, Clone this Record function key, or hit Insert. This creates a new 

record with the different values you have entered. 

Keep in mind, Clone will always insert new data, while Commit either modifies existing 

data or inserts a new data record if you enter all data on a blank, cleared screen. 

(Remember, no R ÆÏÒ Ȱ2ÅÃÏÒÄ ÏÎ 3ÃÒÅÅÎȱȢɊ "Å ÃÁÒÅÆÕÌ ÔÏ ÃÈÏÏÓÅ ÔÈÅ ÃÏÒÒÅÃÔ command for the 

ÄÅÓÉÒÅÄ ÏÐÅÒÁÔÉÏÎȢ 7ÈÅÎ ÍÏÄÉÆÙÉÎÇ Á ÒÅÃÏÒÄȟ ÓÕÃÈ ÁÓ ÃÏÒÒÅÃÔÉÎÇ ÔÈÅ ÓÐÅÌÌÉÎÇ ÏÆ ÁÎ ÏÆÆÅÎÄÅÒȭÓ 

name, be sure to use Commit. If you are adding to a list (i.e., dockets, charges), use Clone to 

ÉÎÓÅÒÔ ÅÁÃÈ ÎÅ× ÒÅÃÏÒÄȢ &ÏÒ ÅØÁÍÐÌÅȟ ÙÏÕ ÄÏÎȭÔ ×ÁÎÔ to modify previous charges; you want 

to add a new one. 

UPDATING A RECORD    

Once you retrieve the data file you want, you can update or modify it, clone it or delete it. To 

update a record, click on the field or fields that you want to edit or change. When you 

ÃÈÁÎÇÅ ÄÁÔÁ ÉÎ ÁÔ ÌÅÁÓÔ ÏÎÅ ÆÉÅÌÄȟ ÔÈÅ ÌÅÔÔÅÒ ȰMȱ ÉÓ ÄÉÓÐÌÁÙÅÄ ÉÎ ÔÈÅ ÓÔÁÔÕÓ ÌÉÎÅ.  To make sure 

your changes are saved, look for the words Record updated in the message line. 
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TO DELETE A RECORD    

Retrieve the record you want to delete, and carefully confirm that this really is the data you 

want to delete. Press the  button, the Delete Record function key, or hit Ctrl-D. The 

record will be erased. Verify this in the message line, where the words, Record deleted, 

should be displayed. 

Although the record has been deleted, the data record is still on the screen. This provides 

you with a back-up in case you deleted the wrong record. If that turns out to be the case, 

click the Commit keystroke to re-insert that data record back into database. If it turns out 

you deleted the correct record, press Clear Screen to remove that data from your desktop. 

REPORTS 

To retrieve reports, click on the Report navigational button at the bottom of the screen. A 

menu of reports will appear, as shown below. 

Because the menu of reports is designed to meet the specific needs of each application 

ÓÃÒÅÅÎȭÓ ÆÕÎÃÔÉÏÎȟ ÔÈÅÒÅ ÁÒÅ ÄÉÆÆÅÒÅÎÔ ÒÅÐÏÒÔÓ ÏÎ ÔÈÅ ÖÁÒÉÏÕÓ ÒÅÐÏÒÔ ÍÅÎÕÓȟ ÄÅÐÅÎÄÉÎÇ ÏÎ 

which desktop you are in.  When you double click on the specific report you want, the 

report will appear, as shown below. Sometimes the report will appear behind the screens 

you already have on your desktop. If that happens, click the Report function key to make 

the report come to the front of all the screens. 

 

There also are some 

reports that will appear 

on your screen as a 

form that needs to be 

completed, such as the 

Booking Sheet, or 

Combined Intake 

Reports Form, which 

is shown here. 
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Lock&Track  can produce a large variety of reports. Some reports show information that 

has already been entered into the database, such as housing changes, as shown on the 

previous page, or offender history, as shown below. 

4ÈÅ ÒÅÐÏÒÔÓ ÁÐÐÅÁÒ ÉÎ ÓÅÐÁÒÁÔÅ ×ÉÎÄÏ×Óȟ ×ÈÉÃÈ ȰÆÌÏÁÔȱ ÏÕÔÓÉÄÅ ÏÆ ÔÈÅ ÄÅÓËÔÏÐȭÓ Ï×Î 

window ɂ this makes it easy to position the windows to compare information between 

them.  Reports can be viewed, printed, written to a file to include in another document, or 

emailed to a colleague.  You may have several report windows open and active at a time. To 

remove the report from your screen, press the GoBack button on that report window.  

The report menu shows all the reports that are available for each application screen.  
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Note that you may have to use the scroll or slider control to the right of the menu list 

to see all of the reports available in that menu. 

APPENDIX : THE TOOLBAR 

The Toolbar in Lock&Track  will look familiar to Windows users. It includes many common 

Windows toolbar functions, as well as some that are specific to L&T .  

To find out what the specific functions do, hover your cursor over the lower right hand 

corner. The example below highlights the Find Data key. 

A couple of time-saving features that are incorporated into this L&T  Toolbar include the 

ÓÔÁÎÄÁÒÄ ÃÕÔ ÁÎÄ ÐÁÓÔÅȟ ÁÓ ×ÅÌÌ ÁÓ ÃÌÏÎÉÎÇ ÏÆ ÆÉÌÅÓȢ "ÕÔ ÌÅÔȭÓ ÔÁËÅ Á ÌÏÏË ÁÔ ÁÌÌ ÔÈÅ Toolbarôs 

features. For each button or control that follows, wÅȭÌÌ ÓÈÏ× ÉÔÓ ÇÒÁÐÈÉÃ ɉÔÈÅ ÂÕÔÔÏÎ ÉÔÓÅÌÆɊȟ 

ÐÒÏÖÉÄÅ ÉÔÓ ÐÒÏÐÅÒ ÎÁÍÅȟ ÉÔÓ ȰÈÏÔ-ËÅÙȱ ÉÎ ÐÁÒÅÎÔÈÅÓÉÓ ÉÆ ÁÖÁÉÌÁÂÌÅ ɉÔÈÉÓ ÉÓ ÔÈÅ ËÅÙÂÏÁÒÄ ËÅÙ 

you can type to activate the same operation as the button itself), and a brief description of 

what the button or control actually does. 

Some reports, or forms, that 

appear on your screen help 

you through the tasks at hand. 

For example, this Booking 

Sheet, or Combined Intake 

Reports form, provide you 

with the questions that need to 

be asked of each offender.  
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 Go Back (Page Up) 

Go Back allows you to go back one screen at a time if you are in the middle of an 

Application Screen process. If you are the start of the Application Screen, such as Intake, 

then Go Back will take you back to the Main Menu, where the Application Screens are 

listed (i.e., Intake, Dockets and Charges, Open Cases, etc.) 
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The downward pointing arrow symbol between Go Back and Go Forward allows you to 

go back to a specific screen where you have been, such as Intake. This key allows you to 

save time by clicking the area where you want to be one time instead of making several 

mouse clicks. 

Forward (Page Down) 

This button allows you to go to the next logical step in the process, depending on which 

Application Screen is in use at the time. This next logical step is usually (but not always) the 

screen that is navigated to by the Page Down navigation button (at the bottom of the 

screen). 

Clear All Data  (Shift Delete) 

This clears all data from all fields on the current screen. Some fields may have their default 

values restored. You can then enter a new record or begin a new search from this point. 

Find Data (Home) 

After search criteria has been entered into selected fields, click on this button to perform 

the search. 
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Commit to Database (Alt Enter) 

Generally, saves data to the database. If you enter data on a previously cleared screen (the 

status R ÆÏÒ Ȱ2ÅÃÏÒÄ ÏÎ 3ÃÒÅÅÎȱ ÉÓ not present), then Commit actually inserts a new data 

record into the database. If, however, a data record is first found and displayed on screen (R 

ÆÏÒ Ȱ2ÅÃÏÒÄ ÏÎ 3ÃÒÅÅÎȱɊȟ ÁÎÄ ÙÏÕ ÍÏÄÉÆÙ ÏÎÅ ÏÒ ÍÏÒÅ ÄÁÔÁ ÆÉÅÌÄÓȟ ÔÈÅÎ Commit simply 

updates this current record with your changes. Make sure you click Commit to save a 

record or any changes to the database.  

Clone this Record (Insert) 

You can use this button to add to a list and to insert a new record rather than modifying one. 

Clone inserts a new record while Commit overwrites an existing record. Use Clone when 

you have first found a data record and it is displayed on the screen (R ÆÏÒ Ȱ2ÅÃÏÒÄ ÏÎ 

3ÃÒÅÅÎȱɊȢ )Æ ÒÁÔÈÅÒ ÔÈÁÎ ÍÏÄÉÆÙÉÎÇ ÏÒ ÕÐÄÁÔÉÎÇ ÔÈÉÓ ÒÅÃÏÒÄȟ ÙÏÕ ×ÁÎÔ ÔÏ derive or clone a new 

record from it, then modify one or more data fields and press Clone to insert the new data 

record. 

Delete this Record (Ctrl-D) 

This will erase a record. To confirm the deletion, look for the words Record deleted in the 

message line. The record has been deleted, but the data is still on the screen. If it turns out 

ÙÏÕ ÄÉÄÎȭÔ ÍÅÁÎ ÔÏ ÄÅÌÅÔÅ ÔÈÅ ÒÅÃÏÒÄȟ ÃÌÉÃË Commit again to re-insert the data. If it turns out 

you deleted the correct record, press Clear Screen to clear that old data from your screen. 

Copy (Ctrl-C)           Cut (Ctrl-X)              Paste (Ctrl-V) 

All three of these functions are the same as those used in Windows. You can Copy or Cut 

words from one data field and Paste them to a different data field. 
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Clear Field (Shift Backspace or Alt Backspace)  

Clears the data value from a field. Put the cursor in the field you want cleared and then 

press Clear Field. 

Undo Last Field Change (Ctrl-U)  

If you make a change in a field and then realize you entered the information in the wrong 

field or decided not to make the change, press Undo Last Field Change. 

Set Default Value for this Field (Alt Keypad_Star) 

In some situations you may want to set a default for a specific field, such as country or 

gender. Enter the default you want to use, such as ñMALEò, and press Set Default to make 

this value the current default for this field. 

Restore Default Value for this Field (Ctrl Keypad_Star) 

Restores the current default value for a field, regardless of whether that field is currently 

blank or has some other value. 

Set Search Qualifiers for Current Field (Ctrl Equal) 
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Use this to search for something that happened between two specific dates, such as 

someone who was born between 1952 and 1959 or to search for an offender arrested 

during an identifiable time period. Other search conditions also are available, such as value 

is less than or greater than, value is not missing, or value is missing, etc. 
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Insert Time Stamp (Ctrl-T) 

Click on this button to enter the current date and timestamp (i.e.ȟ ȰÎÏ×ȱɊȢ !Î ÅØÁÍÐÌÅ ÏÆ Á 

date and time stamped into a Memo Window is shown below. This function can be used in 

any field that can accept either a date/timestamp data value, or a character-string field that 

does not have a validation list. 

 

 

 

Print Current Window to Default Printer (Ctrl-P) 
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This button will send an image of the current screen to your default printer.  

Lock Session (Ctrl-L) 

If you are juÓÔ ÌÅÁÖÉÎÇ ÙÏÕÒ ÃÏÍÐÕÔÅÒ ÆÏÒ Á ÆÅ× ÍÉÎÕÔÅÓ ÁÎÄ ÄÏÎȭÔ ×ÁÎÔ ÔÏ ÌÏÇ ÏÆÆȟ ÃÌÉÃË ÔÈÅ 

Lock button, and your place in the program will be saved. If you are gone for five minutes, 

ÉÔȭÓ Á ÑÕÉÃË ÅÎÔÒÙ ÏÆ ÙÏÕÒ ÐÁÓÓ×ÏÒÄ ÁÎÄ Á ÃÌÉÃË ÏÎ ÔÈÅ ÕÎÌÏÃË ÂÕÔÔÏÎȟ ÁÎÄ ÙÏÕÒ ÁÐÐÌÉcation 

will reappear as you left it.  If, for some reason, you get tied up for a longer time and maybe 

even leave for the day, another staff member can log off for you. 

4Ï ÌÏÇÏÕÔ ÁÎÏÔÈÅÒ ÕÓÅÒȭÓ ÌÏÃËÅÄ L&T  session, click on the Exit button. This will logout that 

other user so that you can login under your own L&T  username and password (as required 

by the system security policy).   

 

View Message Window (Ctrl-M)  

System-wide messages may be broadcast to all users at any time. To check system 

messages, press this button, or use Ctrl-M, or click on the word MSGS in the status line. 
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View Report Window (Ctrl-R) 

Click this button to view reports that are present. In the example below, the Trust Receipt 

for Hairy Wolf is shown with the date and time stamped in the Memo Window. This report 

is on top of the Property and Trust screen because the View Report Window was clicked. 

 

 


